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1 Einleitung

Diese Anleitung beschreibt die Installation, die Konfiguration und die Nutzung des
Zahlungsmoduls flr OpenCart und Barclaycard.

Bevor Sie mit der Installation beginnen kdonnen, stellen Sie sicher, dass Sie im Besitz aller
notwendigen Daten sind:

® PSPID und Passwort erhalten Sie nach Vertragsabschluss oder nach Eroffnung eines Demo
Kontos direkt von Barclaycard

® OpencCart Zzahlungsmodul von sellxed.com/shop

® Zugangsdaten zu Ihrem Server und Shop.

Falls Sie noch nicht im Besitz eines Vertrags mit Barclaycard sind, konnen Sie diesen gerne auch
direkt durch uns beziehen.

Beachten Sie, dass Sie flir unsere Plugins mindestens die PHP Version 5.6 verwenden missen.
PHP 8 oder héher wird derzeit nicht unterstiitzt.

1.1 Ablauf der Installation

In diesem Dokument erhalten Sie alle Informationen, welche flr die Installation des Moduls
notwendig sind. Flr die Inbetriebnahme des Moduls sollten Sie die einzelnen Punkte strikt
befolgen. Nur so kann ein sicherer Einsatz in Ubereinstimmung mit allen Sicherheitsregularien
gewahrleistet werden.

6/41



sellxed

Konfiguration der Administrationsoberflache von Barclaycard.

Konfiguration der Grundeinstellungen des Zahlungsmoduls.

Konfiguration der Zahlungsarten.

Durchfiihrung einer Testbestellung anhand der beigelegten Testdaten am Ende dieses
Dokuments.

5. Sofern der Test erfolgreich verlaufen ist, kopieren Sie alle Daten Ihres Testkontos in das
Live Konto von Barclaycard.

FwbNPe

Installationsservice

Unsere Zahlungsmodule sind standardmadssig so vorkonfiguriert, dass die Installation
gleich nach dem Eintragen der bendtigten Keys funktionieren sollte. Sollten Sie einen
Setting aus der Konfiguration des Moduls nicht kennen, konnen Sie sich gerne mit
unserem Support in Verbindung setzen.

Unser Support Team steht IThnen wahrend der Geschaftszeiten gerne zur Verfligung:
http://www.sellxed.com/support. Sie haben zudem jederzeit die Mdglichkeit unseren
Installationsservice zu bestellen. Wir sorgen flr eine reibungslose Installation in IThrem
Shop: http://www.sellxed.com/shop/de/integration-und-installation.html

.htaccess Verzeichnisschutz

Flr den Test des Zahlungsmoduls muss jeglicher Verzeichnisschutz oder IP Sperre auf
Ihrem Server zwingend ausgeschaltet sein, sonst kann es sein, dass das
Zahlungsfeedback von Barclaycard nicht bis zu Ihrem Shop durchdringt.

1.2 System Anforderungen

Generell hat das Plugin die gleichen Anforderungen an das System wie OpencCart selber.
Nachfolgend finden Sie die wichtigsten Anforderungen des Plugins:

® PHP Version: 5.4.x oder hoher

® OpenSSL: Aktuelle Version mit Unterstltzung von TLS 1.2 oder hoher.

* fsockopen: Die PHP Funktion fsockopen muss zur Verfiigung stehen. Das Plugin muss
Verbindungen zu anderen Servern 0ffnen konnen.

PHP Funktionen: Im weiteren missen alle gangigen PHP Funktionen zur Verfiigung stehen.

Verwenden Sie OpenCart in der Version 3.0.3.5 oder 3.0.3.6, missen Sie ihren Store patchen, um
das Twig-Extension-Problem zu beheben. Dies kann bspw. mit der Installation der folgenden
Extension gelGst werden: https://www.opencart.com/index.php?route=marketplace/extension
/info&extension_id=40469.
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2 Konfiguration Barclaycard - Backend

Loggen Sie sich flr die Konfiguration bei Barclaycard im Backend ein:

® Test Umgebung: https://ndepaynents. epdq. co. uk/ ncol /t est/backoffice
® Live Umgebung: https://paynents. epdg. co. uk/ ncol / prod/ backoffice

Die Parameter welche auf den folgenden Seiten eingestellt werden sind Voraussetzung fir die
spatere Konfiguration des Hauptmoduls.

Die Konfiguration der Einstellungen erfolgt unter Konfiguration > Technische Informationen. Im
folgenden Kapitel entsprechen die Kapiteltberschriften den Tabs im Backoffice von Barclaycard.
An einzelnen Stellen wird zur besseren Verstandlichkeit auch ein Screenshot beigelegt. Sollte
eine Einstellung nicht erwahnt werden, so hat diese flr die Konfiguration des Zahlungsmoduls
keine Bedeutung und kann problemlos ignoriert werden.

2.1 Tab: Globale Transaktionsparameter

Unter Globale Transaktionsparameter definieren Sie die Grundeinstellungen zur Abwicklung der
Transaktionen.
2.1.1 Standardoperationswert und Standarddatenerfassungsprozedur

wir empfehlen Ihnen die Option "Direktbuchung" und "Automatische Datenerfassung durch unser
System am Ende des Tages.", dann werden alle eingehenden Zahlungen direkt verarbeitet und
abgerechnet. Falls Sie das Transaktionsmanagement und verziogerte Verbuchung ausgewahlt
haben, sollten Sie Direktbuchung und Automatische Erfassung wahlen. Im Fall von abweichenden
Einstellungen in Ihrem Modul werden diese Einstellungen tiberschrieben.

2.1.2 Maximale Anzahl Zahlungsversuche

Wir empfehlen Ihnen den Zahler auf 10 zu setzen.

2.1.3 Verarbeitung von Einzeltransaktionen

Generell empfehlen wir Ihnen die Option "Online, jedoch Umstellung auf offline, wenn das Online-
System des Acquirers nicht verfligbar ist.".

2.2 Tab: Globale Sicherheitsparameter

Hier werden die Sicherheitsparameter flr die Interaktion zwischen dem Shop und dem Gateway
von Barclaycard definiert.
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2.2.1 Hash-Methode

Die sellxed Zahlungsmodule unterstutzen alle Hashmethoden. Damit das Modul funktioniert, ist
es entscheidend, dass die Einstellungen im Barclaycard - Backend mit jenen im Shop identisch
sind.

Um eine reibungslose Abwicklung zu garantieren wahlen Sie folgende Einstellungen fir die
Erzeugung des Hashs:

* Jeder Parameter, dem die Passphrase folgt. Es kann sein, dass dieser Parameter in Ihrem
Shop nicht sichtbar ist, in diesem Fall wird es automatisch dbernommen.

® Hash-Algorithmus = SHA 512

e 7Zeichenkodierung = UTF-8

Hashing, method

w This configuration affects all signature checks of which the pass phrases are configured under "Data and origin” and "Feedbacks".

i Hash algorithm
SHA-1
SHA-256
* SHA-S12
i Character encoding

Use the character encoding expected with the initial transaction request (depending on the URL called)
IS0-8859-1

® UTF-2

Abbildung 2.1: Konfiguration des SHA-Hash.

Diese Einstellungen muissen mit den Einstellungen im Hauptmodul Ubereinstimmen (vgl.
Konfiguration des Hauptmoduls). Beachten Sie, dass die Zeichenkodierung in unserem Modulen
standardmassig auf UTF-8 gestellt ist und nicht geandert werden kann.

2.3 Tab: Zahlungsseite

Hier muss die Checkbox "Abbrechen" aktiviert sein. Das Feld 'Weiterleitung fur "Zurtck"-
Schaltflache™ kdnnen Sie leer lassen.

2.4 Tab: Daten- und Ursprungsuberprifung

Der Tab Daten- und Ursprungsiberprifung definiert Sicherheitselemente hinsichtlich der
Ubergabe von Daten und Aufruf der Payment Page.
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2.4.1 0Oberpriifungen fiir e-Commerce & Alias Gateway
Im ersten Feld "URL der Handlerseite" muss nichts eingetragen werden.

Das Feld "SHA-IN Signatur" ist ein Sicherheitsbestandteil der Zahlung, welche deren Echtheit
verifiziert. Es ist deshalb wichtig, dass Sie im Backend und im Shop die gleiche Signatur
verwenden.

Customweb SHA-String Generator

Bitte Beachten Sie, dass fur die SHA-Signaturen nur ASCIl Zeichen verwendet werden
durfen. Damit Sie keine unerlaubten Zeichen benutzen, verwenden Sie bitte unserem
SHA Signaturen Generator

2.4.2 Oberprifungen fir Barclaycard DirectLink

DirectLink erlaubt Ihnen die Nutzung der Hidden Authorisation (Alias Gateway) sowie die direkte
Verbuchung der Transaktionen aus dem Shop heraus. Falls Sie DirectLink in Ihrem Account
aktiviert haben und dieses Feature nutzen mochten, tragen Sie im Feld "SHA-IN Signatur" dieselbe
SHA-Signatur wie oben ein.

Weitere Informationen zur Konfiguration von DirectLink finden Sie unter Konfiguration Hidden
Authorisation.

2.5 Tab:Transaktions-Feedback

Im Tab Transaktions-Feedback wird die Antwort von Barclaycard an den Shop gesteuert.

2.5.1 Standardwerte fiir die HTTP-Umleitungen nach der Zahlung

Die Parameter des Transaktionsfeedback bestimmen die Verarbeitung im Shop nach erfolgter
Zahlung. In den vier Feldern von “HTTP-Umleitung im Browser” mdssen Sie nichts eingeben, da
diese Einstellungen durch unser Modul tbergeben werden.

Die Option "Bei der Umleitung auf eine der URLs soll auf der Bezahlseite ein Hinweis zur
Umleitung durch Barclaycard ausgegeben werden" sollte nicht angewahlt sein.

2.5.2 Direktes Feedback tiiber HTTP-Server-zu-Server-Anfrage

Um ein reibungsloses und zuverlassiges Funktionnieren des Modul zu gewahrleisten, stellen Sie
die Optionen bitte folgendermasse ein:
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* Der Anfragetyp muss auf Online, aber Wechsel zu zeitlich versetzte Anfrage (deferred
Request), wenn die Online-Anfrage fehlschlagt gesetzt werden. Als Anfragemethode
mussen Sie "POST" verwenden.

® Die Option"lch winsche, wahrend der Zahlungsverarbeitung, die Anzeige einer "in
Bearbeitung" Meldung durch Barclaycard an den Kunden." sollte ebenfalls nicht angewahlt
sein.

® Kopieren Sie hier die URL, welche Sie im Shop Backend finden unter: Extensions >
Modifications > Modules > Barclaycard Base Module > Edit > More > Setup.

URL der Handlerseite an die das Transaktionsfeedback gesendet wird

Fur die Rickmeldung des Transaktionsfeedbacks tragen Sie die URL ein, welche das Hauptmodul
direkt flr Sie generiert. Weitere Informationen hierzu finden Sie unter dem Punkt Transaktions-
Feedback.

Alle Bestellungen haben den Status pending / ausstehende
Bestellung

Sollten Sie beim Testen bemerken, dass die Bestellungen im Shop nicht erfasst werden,
respektive der Status nicht aktualisiert wird und keine Bestatigungsemail versendet
wird, hangt dies mit dem Fehlschlagen des Transaktionsfeedbacks zusammen. Stellen
Sie in diesem Fall sicher, dass Ihre Firewall die Anfragen von Barclaycard nicht blockiert.

Direct HTTP server-to-server request
i Timing of the request
Mo request.
Always deferred (not immediately after the payment).

Always online (immediately after the payment to allow customisation of the response seen by the customer).

# Online but switch to a deferred request when the online requests fail.

m URL of the merchant's post-payment page

If the payment's status is "accepted”, "on hold" or "uncertain”.

SEE MANUAL FOR THIS URL // URL GEMASS MANUAL

If the payment's status is "cancelled by the client" or "too many rejections by the acquirer”.

SEE MANUAL FOR THIS URL // URL GEMASS MANUAL|

Request method
& POST

GET

Abbildung 2.1: Konfiguration der Ricksprung URL flir das HTTP-Feedback.

Deferred Requests und Time Out

Barclaycard sendet die Notifikation tber erfolgreiche Zahlungen mit einem Time Out von
20 Sekunden. Sollte Ihr Shop in dieser Zeit nicht antworten, erfolgt ein Time Out Error. Die
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Notifikation wird in der Folge noch 4 mal gesendet in einem Abstand von 10 min., sofern
Sie die obige Einstellung Online, aber Wechsel zu zeitlich versetzte Anfrage (deferred
Request), wenn die Online-Anfrage fehlschlagt gewahlt haben.

Abhangig von Ihrem Account kann es sein, dass flr Sie nur die Option Immer Online
verflgbar ist. In diesem Fall wahlen Sie diese Option.

2.5.3 Dynamische e-Commerce Parameter

Mit dieser Option steuern Sie, welche Parameter durch Barclaycard in der Antwort gesendet
werden sollen. Damit die zahlungen in Ihrem Shop auch wirklich ausgewertet werden kénnen,
mussen alle notwendigen Parameter mitgesendet werden.

Verschieben Sie alle Parameter von verfligbar nach ausgewahlt bis auf folgende Parameter:

° PM

®* CN

* SUBBRAND
® AAVADDRESS
® AAVCHECK
* AAVMAIL

* AAVNAME

* AAVPHONE
® AAVZIP

1 1o select o deselect the parameters you wish to receive a5 feedbaek for 3 transaction and move them from ane box o another. Plesse note that NCERROR, PAYID, ORDERID, STATUS are defaul parameters and selected 13 such and eannot be removed.

Abbildung 2.1: Konfiguration der dynamischen E-Commerce Parameter. Es kann sein, dass bei
Ihnen andere Parameter zur Auswahl stehen abhangig von Ihrem Account. Lassen Sie sich
dadurch nicht verwirren.

2.5.4 Dynamische Parameter

Mit dieser Option steuern Sie, welche Parameter durch Barclaycard in der Antwort gesendet
werden sollen. Damit die zahlungen in Ihrem Shop auch wirklich ausgewertet werden kénnen,
mussen alle Parameter mitgesendet werden.

Verschieben Sie alle Parameter von verfiigbar nach ausgewahit.
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Alias gateway and Tokenization
Dynamic parameters

Available Selected

ALIAS.ALIASID
ALTAS.NCERROR
ALIAS.NCERRORCARDNO
ALIAS.NCERRORCN
ALTAS.NCERRORCWC
ALIAS.NCERRORED

Abbildung 2.1: Konfiguration der dynamischen Parameter. ES kann sein, dass bei Ihnen andere
Parameter zur Auswahl stehen abhangig von lhrem Account. Lassen Sie sich dadurch nicht
verwirren.

2.5.5 Sicherheit der Anfrageparameter

Das Feld "SHA-OUT Signatur" ist ein weiterer Sicherheitsmechanismus der Zahlung. Auch hier
muss die gewahlte Signatur identisch mit derjenigen des Shops sein. Stellen Sie jedoch sicher,
dass sich die SHA-OUT Signatur von der SHA-IN unterscheidet.

Customweb SHA-String Generator

Bitte beachten Sie, dass fur die SHA-Signaturen nur ASCIl Zeichen verwendet werden
durfen. Damit Sie keine unerlaubten Zeichen benutzen, verwenden Sie bitte unserem
SHA Signaturen Generator

2.5.6 HTTP-Anfrage fiir Statusanderungen

Sie haben die Mdglichkeit Uber Statusanderungen direkt von Barclaycard informiert zu werden.
Beispielsweise, wenn die Zahlung in den unsicheren Status verschoben wurde, weil das System
des Acquirers nicht verfugbar war. Der Status der Zahlung wird so automatisch aktualisiert. Es
erlaubt Ihnen aber auch Bestellungen direkt bei Barclaycard zu verbuchen. Mit einer kurzen
Verzogerung, sollte sich dann auch der Status in Ihrem Shop updaten.

Um das Feature der Status Synchronisation zu nutzen, wahlen Sie die Option Fir jede Offline-
Statusanderung (zahlung, Stornierung,...). und tragen die URL ein, welche Sie in dem Hauptmodul
im Shop unter dem Tab Setup finden: Extensions > Modifications > Modules > Barclaycard Base
Module > Edit > More > Setup.

Setzen Sie die URL, die das Modul anzeigt, in das Feld 'URL, an welche der Handler eine
zeitversetzte HTTP-Anfrage (deferred HTTP request) im Falle einer Offline-Anderung eines
Transaktionsstatus winscht' und aktivieren die Option Fiir jede Offline-Statusanderung (Zahlung,
Stornierung,...).
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HTTF request for status changes
i Timing of the request
Mo request.
Omly at the time of the order authorisation request.
#) For each offline status change (payment, cancellation, etc.).

URL on which the merchant wishes to receive a deferred HTTP request, should the status of a transaction change offline.

Abbildung 2.1: Setzen Sie in das URL Feld die URL, welche Sie im Hauptmodul unter Setup finden.

2.5.7 Dynamische Parameter

Verschieben Sie alle Parameter von verfligbar nach ausgewahit.

2.6 (Dynamisches)-Template / Vorlage

Die Option Template finden Sie neu unter Konfiguration > Vorlage. Die dynamische Vorlage
(Dynamic Template Mode) erlaubt es Ihnen, die Eingabemaske der Kreditkartendaten im Design
Ihres Webshops zu gestalten. Sollte das Feld zur dynamischen Vorlage nicht angezeigt werden,
nehmen Sie bitte mit Barclaycard Kontakt auf. Es kann sein, dass noch zusatzliche Optionen in
Ihrem Konto freigeschaltet werden mussen.

Verwenden Sie zur Nutzung des dynamischen Templates folgende Einstellungen:

® Javascript-Prufung: 'Nein'

* Unsere Module unterstitzen die 'Nutzung statischer Vorlagen' nicht. Klicken Sie dort also
auf"Nein".

® Nutzung dynamischer Vorlage erlauben Ja'.

® Falls Sie die dynamische Vorlage benutzen, fligen Sie den Hostnamen, d.h. https://Ihr-Shop.
comindas untere Feld ein. Das obere muss leer bleiben
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Template

Enable JavaScript check on template
Yes

#* No

Allow usage of static template
Yes

#* No

Trusted static template name

i You may enter several template names, separated by ";" (e.q. templatel.htm; template2.php)

Allow usage of dynamic template
# Yes
Mo

Trusted dynamic template URL

i You may enter several template URL, separated by ";" (e.g. https://www.domain.com/tmp/templatel.htm; https://www.domain.com/template2.php)

Trusted website hostname hosting the dynamic template
*

hﬁps:.n’.n‘yourh hop.com

i You may enter several website hostnames, separated by ";" (e.qg. https://www.domain.com; https://www.otherdomain.com)

Abbildung 2.1: Konfiguration des dynamischen Templates.

Dynamic Template

Beachten Sie, dass Sie fur die Nutzung des dynamic Template ein SSL Zertifikat besitzen
mussen. Ansonsten werden die CSS-Ressourcen in gewissen Browsern nicht
nachgeladen. Dies fihrt zu Darstellungproblemen.

Die Aktivierung des Dynamic Template im Shop wird hier beschrieben.

2.7 Hidden Authorisation, Ajax Authorisation (FlexCheckout -
Hosted Tokenization PageS, External Checkout & Alias Manager

Die Nutzung der Hidden Autorisierung, Ajax Autorisierung (FlexCheckout - Hosted Tokenization
Page), Alias Manager oder External Checkout erfordert zusatzliche Optionen. Stellen Sie daher
sicher, dass die Voraussetzungen zur Nutzung erfdllt sind.

2.7.1 Voraussetzungen

Flr die Nutzung von Hidden Authorisation oder Ajax Authorisation (FlexCheckout) in der
Zahlungsverarbeitung sind bei Barclaycard Anpassungen im Backend notig. Uberpriifen Sie, ob
diese Optionen in Ihrem Konto freigeschaltet sind unter Konto > Ihre Optionen.
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Abbildung 2.1: Stellen Sie sicher, dass die Option OPC und DPR aktiviert ist.
Sollte eine Option nicht verfligbar sein, melden Sie sich bitte direkt bei Barclaycard.
Optionen und Bedeutung:

* Firdie Nutzung von Hidden Authorisation bendtigen Sie die Option OnePageCheckout (OPC)
und DirectLink (DPR).

® FUrdie Nutzung von Ajax Authorisation (FlexCheckout) bendtigen Sie die Option
onePageCheckout (OPC) und DirectLink (DPR).

® Wenn Sie zusatzlich den Alias Manager verwenden mochten, benotigen Sie auch noch die
Option Alias Manager (RECX).

Falls diese Optionen nicht verfligbar sind, nehmen Sie bitte direkt mit Barclaycard Kontakt auf.

2.7.2 Erstellen eines APl Users

Flr das Transaktionsmanagement oder die Nutzung des Hidden Modes (Alias Gateway) brauchen
Sie zwingend einen APl Nutzer. Bitte befolgen Sie die unten erwahnten Schritte zur Erstelung
eines solchen Nutzers.

Klicken Sie auf Konfiguration > Benutzerverwaltung auf Neuen Benutzer. Wahlen Sie eine USERID
und legen Sie Benutzername und E-Mail-Adresse an. Als Profil wahlen Sie Administrator ohne
Benutzer Manager. Es ist zudem wichtig, dass Sie die Option Spezieller Benutzer fir API (kein
Zugriff auf die Administration) anwahlen. Sollten Sie diese Option nicht sehen, missen Sie bei
Barclaycard die Konto-Option Barclaycard DirectLink aktivieren lassen.

Passwort des API-Users

Die USERID sowie das API-User Passwort diurfen lediglich Zahlen und Buchstaben
enthalten sowie Sonderzeichen. Die folgenden Sonderzeichen sind nicht erlaubt: &
(Ampersand), " (Double Quotes), ' (Single Quotes).
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Notieren Sie sich die Zugangsdaten. Die einzelnen Daten mussen spater an entsprechender
Stelle bei der Konfiguration des Hauptmoduls eingetragen werden.

2.7.3 Nutzungvon External Checkouts

Flr die Nutzung von External Checkouts sind zusatzliche Optionen notwendig. Unter External
Checkouts verstehen wir Zahlarten, welche die Mdglichkeit der automatischen Adressiibergabe
bieten wie beispielsweise Masterpass.

Die Nutzung der External Checkouts verlangt die Option Direct Link sowie die Aktivierung der
Zahlart in Ihrem Konto.

Damit die Zahlart funktioniert missen Sie sicherstellen, dass unter Technische Informationen >
Transaktionsfeedback im Abschnitt Direct Link alle Parameter nach ausgewahlt verschoben sind.

Directlink

Dynamic parameters

This exchange box allows you to select or deselect the parameters you wish to receive as feedback for a transaction am
such and cannct be removed.

Available Selected
AAVADDRESS
AAVCHECK
AAVMAIL
AAVMNAME
AAVPHONE
AAVZIP

SAVE
Abbildung 2.1: Response Parameter flr Direct Link.
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3 Modul Installation im OpencCart Shop
3.1 Installation

Sie sollten zu diesem Zeitpunkt bereits im Besitz des Moduls sein. Falls nicht erhalten Sie die
Moduldateien in Ihrem Benutzerkonto im sellxed Shop (MenlUpunkt "Meine Downloadartikel"). Um
das Modul in Ihrem OpenCart Shop zu installieren, fihren Sie bitte folgende Schritte durch:

1. Laden Sie das Plugin herunter. Den Download finden Sie in Ihrem sellxed.com Account
unter "Meine Downloadartikel".

. Entpacken Sie das Archive, welches Sie heruntergeladen haben.

. Im entpackten Ordner finden Sie einen Ordner "files"

. Flr einige Shops werden verschiedene Versionen des Plugins zur Verfligung gestellt.

. Laden Sie nun mit Ihrem preferierten FTP Programm den ganzen Inhalt dieses Ordners ins
Stammverzeichnis Ihres Shops. Bei gewissen Shops gibt es einen spezifischen Ordner,
welcher die Plugins enthalt. Sollte dies der Fall sein laden Sie das Plugin in diesen Ordner
hoch. Stellen Sie sicher, dass die Ordner nur zusammengefihrt werden und nicht ersetzt.

6. Falls nicht bereits geschehen, loggen Sie sich bitte in Ihrem Shop ein.

o &~ W N

3.2 Updates und Upgrades

wahrend der Supportdauer, erhalten Sie unbeschrankten Zugriff auf Updates und Upgrades in
Ihrem Kundenkonto. Um tber solche Updates informiert zu werden abonnieren Sie bitte den RSS-
Feed. Mehr Informationen hierzu finden Sie hier: http://www.sellxed.com/de/updates_upgrades.

3.2.1 Update Checklist

Bitte fihren Sie vor jedem Update folgende Schritte durch:
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1. Erstellen Sie immer ein Backup der Files und der Datenbank, bevor Sie mit dem Update
beginnen

2. Testen Sie das Update auf einem Testsystem. Wir testen die Module intern, es kann aber
sein, dass im Zusammenspiel mit anderen Plugins weitere Fehler auftreten.

3. Warten Sie bis die Files vollstandig auf den Server gespielt sind und besuchen Sie dann die
Konfigurationsseite des Hauptmoduls. Falls vorhanden leeren Sie bitte auch noch alle
Caches des Shopssystems

Je nach Update kann es sein, dass eine Datenbankmigration durchgefiihrt werden muss. Wir
empfehlen Ihnen daher, dass Update zu einem Zeitpunkt durchzufthren, an dem nicht zu viele
Kunden auf Ihrem Shop zugreifen.

Vorsicht bei Updates im Live Shop

Besondere Vorsicht ist bei Updates im Live Shop geboten. Testen Sie ein Update immer
zuerst in einem Testsystem. Unser Support Team hilft Ihnen gerne bei Problemen. Bei
Updates direkt im Live-System kann es jedoch zu unterbriichen kommen, welche je nach
Support Ressourcen bis zu 2 Tage dauern konnen.

3.2.2 Update Instruktionen

Bevor Sie das Update aufspielen, lesen Sie bitte die Update Instruktionen. Diese finden sich am
Ende der Pluginseite im Changelog. Sofern nichts weiteres in den Update Instruktionen steht,
konnen die Files einfach tberschrieben werden.
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4 Modul Konfiguration im OpenCart Shop

Die Konfiguration teilt sich in zwei Stufen. Der erste Schritt umfasst die Konfiguration des
Hauptmoduls mit den Grundeinstellungen (vgl. Konfiguration des Hauptmoduls). In einem
zweiten Schritt konnen fir jede Zahlungsart individuelle Konfigurationen vorgenommen werden.
Dies bringt Ihnen volle Flexibilitat und grosste Anpassung an Ihre Prozesse.

Erstellen Sie Backups!

Bitte erstellen Sie auf jeden Fall ein Backup des Hauptverzeichnises lhres Shops. Bei
Problemen kénnen Sie so jederzeit wieder zum Ursprungszustand zurtickkehren.

Im Weiteren empfehlen wir Ihnen die Integration zuerst auf einem Testsystem
durchzufthren. Es kann immer wieder zu Komplikationen mit von Ihnen installierten
Drittmodulen kommen. Bei Fragen steht Ihnen unser kompetenter Support gerne zur
Verfigung.
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5 Besonderheit OpenCart1.5x/2.0/3.0
Installation

Das Modul ist mit OpencCart 2.x und 1.5.x kompatibel. Achten Sie darauf, dass Sie die Dateien des
Ordners files_2.x verwenden, sollten Sie mit OpenCart 2 / MijoShop / AceShop arbeiten.
Verwenden Sie den Order files_1.x, wenn Sie OpenCart 1.5 als Basis nutzen.

Um einen reibungslosen Einsatz zu garantieren, mussen Sie einige Besonderheiten bei den
entsprechenden Versionen beachten.

5.1 Konfiguration des Hauptmoduls

Sie finden die Einstellungen des Hauptmoduls unter "Extension > Modules > Barclaycard Base
Module" . Installieren Sie das Modul indem Sie auf Install klicken.

Mit einem Klick auf Edit gelangen Sie in die Konfiguration des Hauptmoduls. Tragen Sie hier die
Daten in die einzelnen Felder ein. Die bendtigten Daten haben Sie entweder bereits im Backend
von Barclaycard eingetragen oder von Barclaycard in vorheriger Korrespondenz erhalten. Jede
Option wird zudem mit einem kurzen Info Text im Shop nochamls erlautert.

5.2 OpenCart 2.0/ 3.0 - Refresh Modifications

Sollten Sie OpenCart 2.0 verwenden ist es wichtig, dass Sie die Modifications refreshen. Dazu
gehen nach Module > Modifications. Oben Rechts finden Sie den Button refresh. Mit dem Klick
darauf konnen Sie die Modifikationen neuladen. Stellen Sie sicher, dass der Ordner system >
modifications Schreibrechte besitzt.

5.3 Besonderheit OpenCart 1.0 Installation

Sollten Sie OpenCart 1.0 verwenden, dann bendtigen Sie die Extension VQMOD. Weitere
Informationen zur Installation und zum Projekt finden Sie unter https://github.com/vamod
/vamod/wiki/Installing-vQmod-on-Opencart

5.4 Setzen der URL flir das Transaktionsfeedback

Damit die Zahlung in Ihrem Shop richtig verarbeitet werden kann, mussen Sie in der
Konfiguration von Barclaycard mindestens eine Feedback URL angeben. Die einzutragende URL
finden Sie innerhalb Ihres OpenCart Shops direkt unter: __setupForm
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5.5 Konfiguration der Zahlungsart

Nachdem das Hautpmodul erfolgreich konfiguriert wurde, finden Sie unter Extensions >
Payments die Einstellungen zu den einzelnen Zahlungsarten in Ihrem Shop. Jede Zahlungsart
wird Ihnen einzeln aufgelistet. Installieren Sie jene Zahlungsmethoden, welche Sie Ihren Kunden
anbieten mochten. Sie konnen flr jede Zahlungsart individuelle Einstellungen vornehmen und so
die Zahlung optimal an Ihre Prozesse anpassen. Die zentralen Optionen werden in der Folge
genauer erlautert.

Mit dem Klick auf Install wird eine Zahlungsmethode in Ihrem Shop installiert. Klicken Sie auf Edit
um die Konfiguration der Zahlungsart anzupassen.

5.6 Direktes Verbuchen von Bestellungen

Mit der Option "Buchung" legen Sie fest, ob Zahlungen direkt verbucht, oder zuerst autorisiert
werden. Sofern Sie in einem ersten Schritt nur autorisieren mochten, stellen Sie sicher, dass die
Zahlungen spater verbucht werden.

Eine Reservation ist, abhangig von Ihrem Acquiring Vertrag, nur eine gewisse Zeit garantiert.
Sollten Sie in dieser Zeit nicht verbuchen, kann es sein, dass die Autorisierung nicht mehr
garantiert wird. Weitere Informationen zum Prozess der Verbuchung finden Sie weiter unten.

Unterschiedliche Einstellungen zwischen Barclaycard - Backend und
Modul

Es kann sein, dass die Einstellungen im Modul fir die Zahlungsweise Ihre Einstellungen
im Backend von Barclaycard einfach tberschreiben.

5.7 unsicherer Status

Sie kénnen Bestellungen, fir welche die Zahlung noch nicht garantiert werden kann, speziell
markieren. Dies erlaubt Ihnen diese Bestellung vor dem Versand noch einmal manuell zu prifen.

5.7.1 Setzenvon Order-Status

Sie konnen fiur jede Zahlungsart festlegen in welchen Status die Bestellung je nach
Buchungsstatus verschoben werden soll. Es handelt sich hier um den initialen Status der
Bestellung.

5.8 Optional: vValidierung

Mit der Validierung steuern Sie den Zeitpunkt wann eine Zahlungsart im Checkout angezeigt
werden soll. Diese Einstellung ist flir Module relevant bei denen die Benutzung von
Voraussetzungen lhres Kunden abhangig ist. Beispielsweise wenn noch eine Bonitatsprifung
erfolgen soll, oder die Zahlungsart nur in gewissen Landern verfugbar ist. ES kann sein, dass
diese Einstellung bei Ihnen nicht ersichtlich ist. Dann Uberspringen Sie diesen Punkt. Damit die

22 /41



sellxed

Bonitatsprifung beziehungsweise Adressvalidierung auch mit europaischen Zeichen
funktioniert, muss bei gewissen PSP-Einstellungen das Charset des "Blowfish mode" auf "UTF-8"
gesetzt werden.

Sollte die Einstellung ersichtlich sein, haben Sie die Wahl zwischen folgenden Optionen:

¢ Validierung vor Auswahl der Zahlungsmethode: Es erfolgt vor der Auswahl der Methode
eine Validierungsprifung. Sofern die Voraussetzungen nicht erflllt sind, wird die
Zahlungsart nicht angezeigt.

¢ Validierung nach der Auswahl der Zahlungsmethode: Die Priifung der Voraussetzung
erfolgt nach der wWahl und vor der Bestatigung der Bestellung.

e wahrend der Autorisierung: Die Validierungsprufung erfolgt durch Barclaycard wahrend
dem Autorisierungsprozess. Die Zahlungsmethode wird auf jeden Fall angezeigt.

5.8.1 Nutzung mehrer unabhangiger OpenCart Shops

Flr den Fall, dass Sie mehrere unabhangige Shops mit einem Vertrag an Barclaycard
anschliessen mochten, bendtigten Sie zwei sellxed Zahlungsmodule flr beide Shops sowie das
zugehdorige Multishop Modul, welches Sie direkt beim Artikel finden.

1. Entpacken Sie das Multishop Modul und 6ffnen Sie die Datei "router.php"

2. Tragen Sie im Hautpmodul beider Shops im Feld "Shop ID" eine frei definierbare ID ein (bsp.
shop_a und shop_b)

3. Fugen Sie in der Datei router.php des Multishop Moduls folgende Zeile an der
entsprechenden Stelle ein (jeweils fur shop_a und shop_b):
Sredirect['shop_a'l = 'https://www.your-shop.com/index.php?route=barclaycardcw
/process/notify",;

4. Tragen Sie bei Barclaycard unter dem Punkt "Rlckmeldung" anstelle der obgenannten URL
folgende URL ein: http[s]://yourshop.com/router.php

5. Kopieren Sie die Datei router.php in das Hauptverzeichnis Ihres Shops
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6 Einstellungen / Konfiguration von
Zahlungsarten

6.1 Allgemeine Informationen zu den Zahlungsarten

Das Plugin wird mit einer grossen Auswahl von Zahlungsarten ausgeliefert. Sollte eine
Zahlungsart nicht verfligbar sein, bitten wir Sie sich mit uns in Verbindung zu setzen.

Flr die Nutzung einer Zahlungsmethode muss die Zahlungsart in Ihrem Konto bei Barclaycard
und im Shop aktiviert sein. Informationen zur Konfiguration des Zahlungsmoduls finden Sie
weiter oben.

In den folgenden Punkten finden Sie wichtige Informationen zu bestimmten Zahlungsarten, die
sich vom Standard unterscheiden.

6.2 Informationen zum Zahlungszustand

Sie kbnnen fir jede Zahlungsart den initialen Zahlungsstatus individuell definieren (Status fir
autorisierte Zahlungen etc). Dabei definieren Sie den Zahlungsstatus fur die einzelnen Zustande
abhangig von der Verarbeitungsart der Bestellung (verbucht, autorisiert, etc.). Es handelt sich
dabei um den initialen Status, welcher die Bestellung annimmt. Abhdangig von der durch Sie
durchgefihrten Mutationen kann sich der Status andern.

Wichtige Info bezlglich dem Bestellstatus

Setzen Sie den Status nie auf Pending Barclaycard oder einen ahnlich lautenden pending
status, der durch das Modul eingefthrt wird.

6.2.1 Bestellstatus "ausstehend" / bevorstehende Zahlung (oder ahnlich)

Bestellungen mit dem Status '‘pending Barclaycard' sind pendente Bestellungen. Der Status wird
gesetzt, wenn der Kunde flr die Zahlung umgeleitet wird aber nicht erfolgreich zurtickkehrt oder
das Feedback nicht bis zu IThrem Shop gekommen ist (Kunde hat das Fenster auf der Payment
Page geschlossen und die Zahlung nicht abgeschlossen). Abhangig von der Zahlungsart werden
diese Bestellungen automatisch in abgebrochene Bestellungen umgewandelt und der
Lagerbestand wieder freigegeben (sofern der Cronjob Aktiviert ist). Diese Zeitspanne hangt von
den Eigenheiten der Zahlungsart ab, und kann nicht konfiguriert werden.

wenn Sie eine Vielzahl ausstehender Bestellungen haben, deutet dies in der Regel darauf hin,
dass die Notifikationen von Ihrem Webserver zu Barclaycard blockiert werden. In diesem Fall
uberprifen Sie die Einstellungen Ihrer Firewall und bitten den Hoster die IPs und User Agents von
Barclaycard zu aktivieren.
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6.2.2 Abgebrochene / stornierte Bestellungen

Bestellungen, die als abgebrochen markiert werden, wurden wie oben beschrieben automatisch
in diesen Status aufgrund des Timeouts versetzt. Abgebrochen werden aber auch alle
Bestellungen, welche von den Kunden aktivabgebrochen wurden.

6.3 Nutzung Hidden Authorisation / Alias Gateway

Sie haben die Mdéglichkeit Kreditkarten ohne Weiterleitung auf die Payment Page von Barclaycard
abzuwickeln.

Damit Sie dieses Feature nutzen kdnnen mussen Sie zuerst die oben unter Hidden Authorisation
/ Alias Gateway beschriebenen Schritte durchfihren und einen APl User anlegen.

In der Folge kdnnen Sie flr die gewinschten Zahlungsarten die Autorisierungsmethode Hidden
Authorisation aktivieren. Dafiir muossen Sie als Handler den PCI-SAQ-A-EP erflllen.
Kreditkartendaten werden zu keinem Zeitpunkt auf Ihrem Server gespeichert. Kontaktieren Sie
Ihren Acquirer flr weitere Informationen tber den SAQ und Uber die Anforderungen.

6.4 CreditCard

Sie haben bei der Integration die Wahl zwischen einer Integration mit Vorselektierung im Shop, d.
h. der Kunde wahlt den Kartentyp bereits in Ihrem Shop oder eine generische Integration, in
welchem Fall dem Kunden die Zahlungsart Kreditkarte angezeigt wird und er dann erst auf der
Payment Page von Barclaycard den Kreditkartentyp wahlt.
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Order reference : sellxed_og_ 100000091 Beneficiary : customweb GmbH
Total charge : 966.00 CHF

Please select a payment methoed by clicking on the logo.
Card: S5L secured transaction

About Ogone |Privacy policy |Security| Legal info

Cancel

Abbildung 6.1: Keine Vorauswahl der Kreditkartentyps - Diese werden auf der Payment Page
ausgewahlt.

Vorauswahl der Zzahlungart

Wir empfehlen Ihnen die Payment Preselection zu wahlen. Nur diese Integrationsvariante
erlaubt Ihnen fur jede Zahlungsart individuelle Einstellungen zur Verbuchung etc.
vorzunehmen und dem Kunden individuelle Gebuhren pro Zahlungsart zu belasten.

6.5 PayPal

Sie kdnnen PayPal direkt Giber Barclaycard abwickeln. Daflir sind jedoch einige Anpassungen in
Ihrem PayPal Konto notwendig. Fir die Nutzung von PayPal fihren Sie bitte folgende Schritte aus:

1. Aktivieren Sie das Zahingsmodul in Threm Shop

2. Stellen Sie sicher, dass die Zahlungsmethode in Ihrem Konto bei Barclaycard
freigeschaltet ist

3. Die APl Anpassungen in Ihrem PayPal Konto missen vorgenommen werden. Die einzelnen
Schritte werden im "PayPal Express Checkout Integration Guide" erklart. Dieses Dokument
finden Sie in IThrem PSP Konto unter: Support > Integrations- und Benutzerhandblcher >
Technische Handblicher > Barclaycard PayPal Express Checkout Integration Guide .
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6.6 Besonderheiten fir die Integration von MasterPass

Wenn Sie MasterPass als Zahlung in Ihrem Shop anbieten, haben Sie die wWahl zwischen dem
External Checkout und der Integration als Standard-Zahlungsart. Beim External Checkout muss
der Kunde keine Adressdaten mehr im Checkout erfassen. Diese werden direkt von MasterPass
ubermittelt. Der Kunde braucht einzig ein MasterPass Konto. Um diese Funktionen als Handler
nutzen zu kénnen, mussen Sie zwingend die Zahlart MasterPass bei Barclaycard aktivieren
lassen.

Bitte beachten Sie, dass es sein kann, dass flr die Nutzung von gewissen Zusatzfunktionen wie
die Adressubergabe flr Masterpass zusatzliche Optionen bei Barclaycard aktiviert werden
mussen.

Um MasterPass gemass den Vorgaben von MasterCard zu verwenden beachten Sie bitte die
folgenden Information bevor Sie die Zahlart verwenden.
6.6.1 Integrationsvarianten von Masterpass

MasterPass kann als normale Zahlart mit Weiterleitung zu Barclaycard oder als External
Checkout Integriert werden.

6.6.1.1 MasterPass als Zahlart

Wenn Sie MasterPass als normale Zahlart integrieren moéchten, aktivieren Sie die Zahlart einfach
wie gewohnt (vgl.Konfiguration der Zahlungsart). In diesem Szenario wird der Kunde fir die
Zahlung zu MasterPass und dann direkt zum Wallet seines Issuers weitergeleitet.

6.6.1.2 MasterPass als external Checkout

wenn Sie MasterPass als extern Checkout integrieren, konnen Sie die notwendigen Schritte zur
Bezahlung drastisch senken. Die Adressiibergabe und das Anlegen des Kontos geschieht direkt
via MasterPass. Wenn Sie den External Checkout aktivieren, erscheint im Warenkorb ein
MasterPass Button mit welchem nach erfolgtem Login direkt in den letzten Schritt der
Bestellbestatigung gesprungen werden kann. Anlegen des Kontos geschieht im Hintergrund.

Um den External Checkout zu aktivieren gehen Sie in nach Extensions > Modifications > Modules
> Barclaycard Base Module > Edit > More . Dort finden Sie alle Einstellungen zu den external
Checkouts:
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Scope der Konfiguration: Externer Checkout

Standardkonfiguration

-
[

PSP Active * Active [STORE VIEW]
Markieren Sie dieses Feld um den externen Checkout
Uber zu aktivieren.
Externer Checkout Sort Order* 0 [STORE VIEW]
Legen Sie die Reihenfolge fest, in der externe
Checkouts angezeigt werden sollen.
Minimal Order Total* [STORE VIEW]
Define a minimal order total for this checkout to be
available.
Maximal Order Total * [STORE VIEW]

Define a maximal erder total for this checkout to be
available.

Abbildung 6.1: Aktivieren des external Checkouts.

MasterPass als external Checkout ist nicht in allen Fallen verfigbar. Sollte dieser Menudpunkt
nicht ersichtlich sein, nehmen Sie bitte mit uns Kontakt auf.

6.6.2 MasterPass Learn More Button im Checkout

Wenn Sie MasterPass als Zahlungsart anbieten im Normalen Checkout ohne Adressiibergabe
mussen Sie zwingend die MasterPass Learn More Page verlinken. Daflir navigieren Sie in die
Konfiguration der Zahlungsart. Im Feld Beschreibung fliigen Sie bitte einen Link auf die Learn
More Page fur die jeweiligen Sprachen ein. Somit wird auf der Auswahl der Zahlungsart das Feld
Learn More angezeigt.

Die wichtigsten Links haben wir Ihnen hier zusammengestellt. Sie missen lediglich den Inhalt in
das Feld Beschreibung kopieren:

® Deutsch:<a href="https://www.mastercard.com/mc_us/wallet/learnmore/de/DE/" target="
_blank">Mehr Erfahren </a>

® Franzosisch:<a href="https://www.mastercard.com/mc_us/wallet/learnmore/fr/FR/"
target="_blank">apprendre plus </a>

® Englisch: <a href="https://www.mastercard.com/mc_us/wallet/learnmore/en/DE/"
target="_blank">Learn More </a>

® Spanisch:<a href="https://www.mastercard.com/mc_us/wallet/learnmore/en/ES/"
target="_blank">aprender mas </a>

® |talienisch:<a href="https://www.mastercard.com/mc_us/wallet/learnmore/it/IT/"
target="_blank">saperne di pit </a>

* Hollandisch:<a href="https://www.mastercard.com/mc_us/wallet/learnmore/nl/NL/"
target="_blank">Leer Meer </a>
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Altiviert Alctiviert , [STORE VIEW]
Dieze Zahlungsmethode aktivieran

Titel MasterPass [STORE VIEW]
Mame der Zahlungsmethode

Beschreibung <3 [STORE VIEW]

href="https:ffwww.mastercard.com'mec_usiwalletle
arnmore/de/DE™ target="_blank"=Mehr Erfahren
</g=

Beschreibung der Zahlungsmethode

Abbildung 6.1: Einfligen einer Beschreibung am Beispiel von Magento. Diese Einstellungen finden
Sie in der Konfiguration zur Zahlungsart MasterPass.
[} Payment Information

O MasterPass

BUY WITH
MasterPass "

Mehr Erfahren

Abbildung 6.1: Im Frontend sollte dann der Link zur Learn More Page erscheinen.

Links fur weitere Sprachen finden Sie in diesem Dokument: https://developer.mastercard.com/...

6.6.3 Weiterflihrende Informationen

Allgemeine und weiterfihrende Informationen zur Verwendung der Markennamen und Log0s
rund um MasterPass in Ihrem Webshop finden Sie im offiziellen MasterPass Mechant Branding
Requirement Dokument, welches Sie direkt hier abrufen kbnnen: https://developer.mastercard.
com/...

6.7 Nutzung der Ajax Authorization (FlexCheckout)

Sie haben die Mdglichkeit Kreditkarten ohne Weiterleitung auf die Payment Page von Barclaycard
abzuwickeln.

Damit Sie dieses Feature nutzen kdnnen muassen Sie zuerst die oben unter Hidden Authorisation,
FlexCheckout (Hosted Tokenization Page), External Checkout und Alias Manager beschriebenen
Schritte durchfihren und einen APl User anlegen.

In der Folge kdnnen Sie fur die gewlnschten Zahlungsarten die Autorisierungsmethode Ajax
Authorization (FlexCheckout) aktivieren. Kreditkartendaten werden zu keinem Zeitpunkt auf
Ihrem Server gespeichert.
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7 Das Modul in Aktion

In der Folge finden Sie eine Ubersicht tiber die wichtigsten Funktionen im téglichen Gebrauch
des Barclaycard Moduls.

7.1 Nutzliche Transaktionsinformationen zur Bestellung

Sie finden in jeder Bestellung, die mit unserem Modul abgewickelt wurde, eine Ubersicht iber
die wichtigsten Informationen zur Transaktion. Unter anderem erauben diese Informationen die
eindeutige Zuordnung der Bestellungen zu den Transaktionen, welche Sie bei Barclaycard im
Backend sehen.

D Orders

Order Details OrderiD #2

Payment Details Invoice No. [ Generate ]

Shipping Detalls Store Name: Your Store
— Store Url: hitp:fidemo.sellxed.comiu

History Customer Sascha kriisi

Customer Group Default

E-Mail: info@customweb.ch

Telephone 33123456798

Total: 78.80€

Order Status: Pending

IP Address. 160.85.155.47

User Agent Mozilla/5.0 (X11; Linux x BE_64) AppleWebKit/537.36 (KHTML, like Gecko) Ubuntu Chromium/30.0.1599.114 Chrome/30.0.1599.114 Safari/537.36

Accept Language: de,en-USiq=0.8en:q=0.6

Date Added: 13/11/2013

Date Modified 13/11/2013

Abbildung 7.1: Transaktionsinformationen in OpencCart.

7.2 Nutzung des Alias Managers / Token LOsung

Mit dem Alias Manager konnen Kreditkarten Ihrer Kunden flr spatere Einkdaufe sicher bei
Barclaycard gespeichert werden. Die Nutzung wird aktiviert indem Sie die Option "Alias Manager"
in der Konfiguration der Zahlungsart aktivieren. Fir spatere Einkaufe kann der Kunde zwischen
den bereits gespeicherten Karten wahlen und muss so nicht die gesamte Karte nochmals
erfassen.
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Use Stored Card | ooooooooox 0111 7

Card Holder Name*  Sascha krusi

Please enter here the card holder name on the card.

Card Number* 0000 0000 00 0111
Please enter here the number on your card.

Card Expiration® 12 Y 2015 ¥

Select the date on which your card expires.

CVC Code*

Please enter here the CVC code from your card. You find the code on the back of the card.

Confirm Order

Abbildung 7.1: Alias Manager

Alias Manager Optionen

Die Nutzung des Alias Mangers bendtigt die Freischaltung der entsprechenden Option bei
Barclaycard. Nehmen Sie daflr bitte direkt mit dem Support kontakt auf.

7.3 Dynamic Template

Bei allen sellxed Modulen wird bereits ein Standard Skin flr die Nutzung des dynamischen
Templates mitgeliefert. Sie aktivieren die Option indem Sie beim Hauptmodul die Option
"Dynamic Template" auf "Shop Template verwenden" stellen. Stellen Sie sicher, dass im Backend
von Barclaycard, die unter Vorlage beschriebenen Einstellungen vorgenommen wurden.

Das Dynamic Template erlaubt Ihnen die Darstellung der Payment Page im Design Ihres Shops.
Der Kunde bemerkt nicht, dass er fur die Eingabe auf die Website von Barclaycard weitergeleitet
wurde. Das Template passt sich dynamisch Ihrem Shop Template an. So kdnnen Sie auch Mobile
Skins einfach einbauen (vgl. Screenshots)

Dynamic Template benotigt ein SSL Zertifikat

Damit das Dynamic Template in allen Browsern korrekt dargestellt wird, bendtigen Sie
ein SSL Zertifikat in Ihrem Shop.
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Abbildung 7.1: Beispiel: Das Skin passt sich dynamisch dem Ihrigen an.

' M DemoShop Barclaycard  x ﬂ

<« C'  { nttps://mdepaymentsyy =
Yahoo! Sports Fanta... @ Backend

Pay with :

Cardholder' y
ke sname- Test Payment

Card number*

Expiry date (mm (V]
i
yyyyy
: (V]
Card verification
code*
I What is this?
* Mandatory fields

Yes, | confirm my payment

Abbildung 7.1: Beispiel: Dynamic Template mit mobilem Skin

7.4 Verbuchen / Stornieren von Bestellungen

7.4.1 Verbuchen von Bestellungen

Um Bestellungen zu verbuchen, 6ffnen Sie den Transaktionsmanager unter Sales > Barclaycard
Transactions. Hier finden Sie eine Ubersicht iber alle Transaktionen. Suchen Sie Die Bestellung
im Feld der Bestellnummern. Mit "view" 6ffnen Sie die Transaktion zur Bestellung.
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7.4.1.1 Verbuchen kompletter Bestellungen oder Teilverbuchung (partial Capturing)

Durch den Klick auf den Button "Capture Transaction" 0ffnet sich ein neues Eingabefeld. Sie
kdnnen nun jeden Artikel einzeln verbuchen, sofern Sie nicht alle Artikel auf einmal versenden
kénnen. Die Anzahl der Verbuchung von Teilbetragen hangt von Ihrem Vertrag ab. Erkundingen
Sie sich diesbeziiglich direkt bei Barclaycard.

Verbuchung von Bestellungen im Backend von Barclaycard

Das Transaktionsmanagement zwischen Barclaycard und Ihrem Shop ist nicht
synchronisiert. Wenn Sie Zahlungen im Backend von Barclaycard verbuchen, wird der
Status im Shop nicht angepasst und ein zweites Verbuchen im Shop ist nicht moéglich.

Falls Sie nicht alle Artikel der Bestellung verbuchen wollen, kdnnen Sie die Transaktion durch
anklicken des Kastchens auch flir spatere Verbuchungen schliessen.

PARTIAL CAPTURE

With the following form you can perform a partial capture.

Name SKU Type Tax Rate Quantity Total Amount (excl. Tax) Total Amount (incl. Tax)
iPhone product11  product 0% | 1 | 74.24 | 74.24
Flat Shipping Rate  shipping shipping 0% | 1 | 3.68 | 3.68

Total Capture Amount: 77.91 EUR

Close transaction for further captures

Abbildung 7.1: Verbuchen von Bestellungen.

Partial Capturing

Erkundigen Sie sich, ob mehrere Verbuchungen von Barclaycard in Ihrem Vertrag
unterstltzt werden. Sonst kann es vorkommen, dass die Transaktion bei einer
Teilverbuchung fiir spatere Verbuchungen geschlossen bleibt.

7.4.2 Bestellungen stornieren

Mit dem Klick auf "Cancel Transaction" erfolgt ein Storno der Transaktion und der reservierte
Betrag wird auf der Karte Ihres Kunden sofort freigegeben.
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Capture Transaction Refund Transaction

Abbildung 7.1: Capture oder Cancel in OpencCart.
7.5 Ruckvergliten von Bestellungen
Um Bestellungen rickzuverglten, 6ffnen Sie die Transaktionsinformationen (vgl. oben).

Sie kénnen jeden einzelnen Artikel oder einen beliebigen Betrag rickerstatten indem Sie die
Totalbetrage oder die Anzahl Artikel anpassen.

PARTIAL REFUND

With the following form you can perform a partial refund.

Name SKU Type Tax Rate Quantity Total Amount (excl. Tax) Total Amount (incl. Tax)

iPhone product11  product 0% | 1 | 74.24 [ 74.24

Flat Shipping Rate  shipping shipping 0% | 1 | 368 | 368
Total Refund Amount: 77.91 EUR

Close transaction for further refunds

Abbildung 7.1: Refunds in OpencCart fir Barclaycard.

Maximaler Refund

Mit unserem Zahlungsmodul kénnen Sie nie mehr als 100% des urspringlich
autorisierten Betrages zuruckerstatten.

Durch das Ausfihren einer Gutschrift verandert sich der Zustand der Bestellung nicht.
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7.6 Einrichten CronJob

Um die zeitgesteuerten Funktionen des Plugins zu aktivieren (bspw. Update Service, Loschen
pendenteter Bestellungen, etc.) mussen Sie in OpenCart Cron Jobs einrichten. Insbesondere die
Update funktion ermdglicht Ihnen nachtragliche Anderungen der Transaktion bei Barclaycard
Uber die API abzuholen (Bitte beachten Sie, dass es sein kann, dass hier zusatzliche Optionen
freigeschaltet werden muissen.

Damit die zeitgesteuerten Aktionen durchgefihrt werden richten Sie bitte einen Cron Job in
Ihrem Server auf folgenden Controller ein:

https://www.your-shop.com/index.php?route=barclaycardcw/cron/cron

Wir empfehlen Ihnen hier eine Cron Engine wie beispielsweise EasyCron. Damit kdnnen Sie die
Datei (URL) mit einem externen Service aufrufen
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8 Testing

sellxed

Bevor Sie vom Test Modus in den Live Modus wechseln, sollten Sie das Modul ausfihrlich testen.

Testen

Vergessen Sie nicht, nach erfoglreichem Testing den Betriebsmodus von Test auf Live

umzustellen.

8.1 Testdaten

Nachfolgend finden Sie die Testdaten fur die Zahlungsmethoden:

Credit / Debit Card

Kartennummer
Expiry Date
cvc

Kartennummer
Expiry Date
cvc

Kartennummer
Expiry Date
cvc

Kartennummer
Expiry Date
cvc

American Express

Kartennummer
Expiry Date
Ccvc

MasterCard
Kartennummer
Expiry Date
cvc

Visa
Kartennummer
Expiry Date
cvc

Kartennummer
Expiry Date
Ccvc

3750 0000 000 0007
12/2020
1234

5399 9999 9999 9999
12/2020
123

41111111 11111111
12/2020
123

4000 0000 0000 0002
12/2020
123

3750 0000 000 0007
12/2020
1234

5399 9999 9999 9999
12/2020
123

4000 0000 0000 0002
12/2020
123

41111111 11111111
12/2020
123

American Express

Mastercard

VISA (Without 3-D Secure Check)

VISA (With 3-D Secure Check)

American Express

Mastercard

VISA (With 3-D Secure Check)

VISA (Without 3-D Secure Check)
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9 Fehler und deren Losungen

Sie finden ausfihrliche Informationen unter http://www.sellxed.com/de/faq. Sollte sich Ihr
Problem mit den zur Verfligung gestellten Informationen nicht 16sen lassen, melden Sie sich
bitte direkt bei uns: http://www.sellxed.com/de/support

9.1 Die Referrer URL erscheint in meinem Analytics Tool

Unter Umstanden kann die Referrer URL von Barclaycard falschlicherweise im Analytics Tool
erscheinen. Dies passiert, wenn der Kunde mit einer HTTP Header Weiterleitung zurick in den
Shop geleitet wird. Die meisten Analytic Tools kdnnen dieses Problem jedoch minimieren, indem
die entsprechende URL aus dem Report ausgeschlossen wird.

FUr Google Analytics hilft dieses Step-by-Step Guide am Beispiel von PayPal: Weitere Infos sind
unter Punkt 4 beschrieben.
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10 Kompatibilitat zu Third-Party Plugins

Unten aufgefliihrte Plugins sind kompatibel mit unseren Zahlungsmodulen und erleichtern Ihnen
in gewissen Bereichen die Arbeit.

10.1 Geburtstag und Geschlecht in OpenCart

Flr gewisse Zahlungsanbieter ist es n6tig den Geburtstag sowie das Geschlecht des Kunden zu
prifen. OpenCart tut dies standartmassig nicht.

Geburtstag und Geschlecht Abfragen in ihren Checkout einfigen

1. Fugen Sie dem Checkout Ihres Shops zwei neue Custom Fields hinzu. Dies konnen
Sie im Backend Ihres Shops unt ""Customers > Custom Fields" tun.

2. Modifizieren Sie dann die "order context getters" so, dass diese den Wert der Order
/ Session (oder wo immer der vorgangige Schritt die Daten speichert) zurtick
deben.

Order Context Getters

* AbstractOrderContext
* getBillingDateOfBirth()
e getBillingGender()

Diese Funktionen finden Sie in "system/library/cw/Barclaycard
/AbstractOrderContext.php".
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11 Error Logging

Das Modul logged verschiedene unerwartete Fehler und sonstige Fehler abhangig vom
konfigurierten Logging Level. Sollte es ein Problem mit dem Modul geben kann das Log Hinweise
auf dessen Ursache liefern.

11.1 Log Levels

Sie k6nnen das Log Level in den Einstellungen von Barclaycard konfigurieren.

® Error: Logt nur unerwartete Fehler. (Standart)
* |nfo: Logt zusatzliche Informationen.
* Debug: Logt debugging relevante Informationen.

11.2 Pfad der Log Datei

Die Log Datei wird standarmassig im Log Ordner von OpencCart gespeichert. Der Pfad wir in der
config.php Ihres Shops gespeichert. (Standart Pfad: {shopRootDirectory}/system/logs oder
{shopRootDirectory}/system/storage/logs)
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12 Erweiterte Informationen

Dieser Abschnitt des Manuals beinhaltet Informationen fir Anwender mit speziellen
Anforderungen. Samtliche hier aufgefiihrte Informationen und Konfigurationen sind optional
und flr die normale Verwendung des Plugins nicht erforderlich.

12.1 Transaction Object

In diesem Abschnitt finden Sie Informationen wie Sie Daten zu einer Transaktion aus der
Datenbank auslesen kdnnen um diese, z.B. in einem ERP System, weiter zu verarbeiten.

Fir die Code Snippets in diesem Abschnitt wird angenommen, dass sich Ihr Script im
Stammordner des Shops, in einer Standart Ordnerstruktur befindet.

In your script initialize the base of OpenCart.
Opencart 3.X

requi re_once(' config. php');

requi re_once(Dl R_SYSTEM . 'startup.php');
/'l Registry

$registry = new Registry();

/'l Config

$config = new Config();

$confi g->l oad(' default');

$config->l oad(' catal og');

$regi stry->set (' config', $config);

$l oader = new Loader ($registry);

$registry->set('load , $loader);

$regi stry->set (' db', new DB($config->get('db_type'), $config->get
('db_hostnane'), $config->get('db _usernane'), $config->get

(' db_password'), $config->get('db_database'), $config->get('db _port')));

Include the module specific files and set registry.

requi re_once DIR_SYSTEM 'library/cwinit.php';

require_once DIR _SYSTEM ' | i brary/cw BarclaycardCw Util . php';

requi re_once DIR_SYSTEM 'l i brary/cw Barcl aycardCw Entity/ Transacti on. php'
Barcl aycardCw Util:: setRegistry($registry);

Now you can load the transaction and then extract the transactionObject.
Load the transaction by Id:

$transactionByld = Barcl aycardCw _Entity_ Transaction::|oadByld
($transactionld);
$transacti onChj ect = $transacti onByl d->get Transacti onCbj ect () ;

Load transactions by Order ID:
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$transactionsByOrderld = BarclaycardCw Entity_Transaction::
get Transacti onsByOrder | d( $orderld);
foreach($transacti onsByOrderld as $transaction){
$transacti onObj ect = $transacti on->get Transacti onObj ect ();
/1 Do sonething with each object
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